
INSTALLATION GUIDE

SCXI -1313A Terminal Block
This guide describes how to install and use the SCXI-1313A terminal block 
with an SCXI-1125 module.

The SCXI-1313A terminal block is shielded and has screw terminals that 
provide input connections for the SCXI-1125. Each SCXI-1313A channel 
has a precision 100:1 resistive voltage divider that you can use to measure 
voltages of up to 150 Vrms or ±150 VDC. You can individually bypass these 
voltage dividers for low-voltage measurement applications.

The terminal block has 18 screw terminals for easy signal connection. 
One pair of screw terminals connects to the SCXI-1125 chassis ground. 
The remaining eight pairs of screw terminals connect signals to the eight 
analog inputs.

Conventions
The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash. When this symbol is marked on 
a product, refer to the Read Me First: Safety and Radio-Frequency 
Interference for information about precautions to take.

When symbol is marked on a product, it denotes a warning advising you to 
take precautions to avoid electrical shock.

When symbol is marked on a product, it denotes a component that may be 
hot. Touching this component may result in bodily injury.

™



bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 
to a key concept. Italic text also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.

What You Need to Get Started
To set up and use the SCXI-1313A terminal block, you need the following 
items:

❑ Hardware

– SCXI-1313A terminal block

– SCXI-1125 module

– SCXI or PXI/SCXI combination chassis

– Cabling and sensors as required for your application

❑ Tools

– Number 1 and 2 Phillips-head screwdrivers

– 1/8 in. flathead screwdriver

– Long-nose pliers

– Wire cutter

– Wire insulation stripper

❑ Documentation

– SCXI-1313A Terminal Block Installation Guide

– Read Me First: Safety and Radio-Frequency Interference

– DAQ Getting Started Guide

– SCXI Quick Start Guide

– SCXI-1125 User Manual

– SCXI chassis or PXI/SCXI combination chassis user manual

You can download needed documents from ni.com/manuals.
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Connecting Signals

Note Refer to the Read Me First: Safety and Radio-Frequency Interference document 
before removing equipment covers or connecting or disconnecting any signal wires.

To connect the signal to the terminal block, refer to Figures 1 and 2 while 
completing the following steps:

Figure 1.  SCXI-1313A Parts Locator Diagram

1. Unscrew the top cover screws and remove the top cover.

2. Loosen the strain-relief screws and remove the strain-relief bar.

3. Prepare the signal wire by stripping the insulation no more than 
7 mm (0.28 in.).

1 Top Cover Screws
2 Top Cover
3 Terminal Block Enclosure
4 Thumbscrew (2)

5 Rear Connector
6 Circuit Board
7 Safety-Ground Lug

8 Circuit Board Attachment Screws
9 Strain-Relief Bar
10 Strain-Relief Screws

WARNING:
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4. Run the signal wires through the strain-relief opening. If necessary, 
add insulation or padding.

5. Insert the stripped end of the signal wires fully into the terminal. Make 
sure no exposed wire extends past the screw terminal. Exposed wire 
increases the risk of a short circuit that can cause circuit failure.

Figure 2.  SCXI-1313A Circuit Board Parts Locator Diagram

6. Tighten the terminal screws to a torque of 0.57 to 0.79 N ⋅ m 
(5 to 7 lb - in.).

7. Reinstall the strain-relief bar and tighten the strain-relief screws.

8. Reinstall the top cover and tighten the top cover screws.

9. Attach the SCXI-1313A to the SCXI-1125 using the thumbscrews.

10. Refer to the SCXI Quick Start Guide to power on the SCXI chassis and 
configure the system in software.

Note For accurate cold-junction compensation, place the chassis away from an extreme 
temperature differential.

1 Serial Number
2 Assembly Number and Revision Letter
3 Relays to Enable or Bypass the Attenuator (8 places)
4 Chassis Ground Terminal (2 places)
5 Product Name

6 Thermistor
7 Screw Terminal (16 places)
8 Channel Labeling (8 places)
9 Voltage Divider (8 places)

3

1 2

68 7 4

9

5
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Configuring the High-Voltage Attenuator
Each channel has a 100:1 high-voltage attenuator. To enable or disable 
the attenuator, either change the default configuration settings for the 
SCXI-1313A in Measurement & Automation Explorer (MAX) or adjust 
the input limit ranges in your application. When using virtual channels, the 
input limits configured in the virtual channel configurator are used to set 
the attenuation circuitry appropriately.

Note SCXI-1313 is the designator for both the SCXI-1313 and SCXI-1313A in MAX 
and NI-DAQ.

The calibration EEPROM on the SCXI-1313A stores calibration constants 
that provide software correction values. These values are used by the 
application development software to correct the measurements for gain 
errors in the attenuation circuitry.

Table 1.  Input Signal Range Versus Gain

Overall 
Gain Overall Voltage Range1

Module 
Gain

Terminal 
Block Gain

0.02 ±150 Vrms or ±150 VDC 2 0.01

0.05 ±100 Vpeak or ±100 VDC 5 0.01

0.1 ±50 Vpeak or ±50 VDC 10 0.01

0.2 ±25 Vpeak or ±25 VDC 20 0.01

0.5 ±10 Vpeak or ±10 VDC 50 0.01

1 ±5 Vpeak or ±5 VDC 1 1

2 ±2.5 Vpeak or ±2.5 VDC 2 1

2.5 ±2 Vpeak or ±2 VDC 250 0.01

5 ±1 Vpeak or ±1 VDC 5 1 

10 ±500 mVpeak or ±500 mVDC 10 1

20 ±250 mVpeak or ±250 mVDC 20 1

50 ±100 mVpeak or ±100 mVDC 50 1

100 ±50 mVpeak or ±50 mVDC 100 1

200 ±25 mVpeak or ±25 mVDC 200 1

250 ±20 mVpeak or ±20 mVDC 250 1
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Calibrating the Terminal Block
Most external calibration documents for SCXI product are available to 
download from ni.com/calibration by clicking Manual Calibration 
Procedures. For external calibration of products not listed there, Basic 
Calibration Service or Detailed Calibration Service is recommended. 
You can get information about both of these calibration services at 
ni.com/calibration. NI recommends performing an external 
calibration once a year.

Temperature Sensor Output and Accuracy
The SCXI-1313A temperature sensor outputs 1.91 to 0.65 V from 
0 to 50 °C.

Converting a Thermistor Voltage to a Temperature
NI software can convert a thermistor voltage to the thermistor temperature 
for the circuit diagram shown in Figure 3. In LabVIEW, you can use the 
Convert Thermistor Reading VI found in the Data Acquisition»Signal 
Conditioning palette. If you are using CVI or NI-DAQmx, use the 
Thermistor_Convert function. The VI takes the output voltage of the 
temperature sensor, the reference voltage, and the precision resistance and 
returns the thermistor temperature.

Alternatively, you can use the following formulas:

500 ±10 mVpeak or ±10 mVDC 500 1

1000 ±5 mVpeak or ±5 mVDC 1000 1

2000 ±2.5 mVpeak or ±2.5 mVDC 2000 1

1 Refer to the Specifications section for the input range.

Table 1.  Input Signal Range Versus Gain (Continued)

Overall 
Gain Overall Voltage Range1

Module 
Gain

Terminal 
Block Gain

T(°C ) TK 273.15–=
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where TK is the temperature in Kelvin

a = 1.295361 × 10–3

b = 2.343159 × 10–4

c = 1.018703 × 10–7

RT = resistance of the thermistor in ohms

VTEMPOUT = output voltage of the temperature sensor

where T(°F) and T(°C) are the temperature readings in degrees Fahrenheit 
and degrees Celsius, respectively.

Note Use an average of a large number of samples to obtain the most accurate reading. 
Noisy environments require more samples for greater accuracy.

Reading the Temperature Sensor in LabVIEW
In LabVIEW, to read VTEMPOUT, use NI-DAQmx with the following string:

SC(x)Mod(y)/_cjTemp

To read VTEMPOUT with Traditional NI-DAQ (Legacy), use the address 
string:

obx ! scy ! mdz ! cjtemp

You can have this channel-address string in the same channel-string array 
as other channels on the same SCXI-1125 module and call it multiple times 
within the same channel-string array.

For more information about channel-string arrays and the SCXI 
channel-addressing syntax, see the LabVIEW Measurements Manual.

TK
1

a b RTln( ) c RTln( )3+ +[ ]
--------------------------------------------------------------=

RT 5,000 
VTEMPOUT

2.5 VTEMPOUT–
--------------------------------------⎝ ⎠
⎛ ⎞=

T °F( ) T °C( )[ ]9
5

----------------------- 32+=
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Temperature Sensor Circuit Diagram
You do not need to read this section to operate the SCXI-1313A. 
The circuit diagram in Figure 3 is optional information that you can use 
if you want more details about the SCXI-1313A temperature sensor.

Figure 3.  Temperature Sensor Circuit Diagram

Specifications
All specifications are typical at 25 °C unless otherwise specified.

Input range ..............................................150 Vrms or VDC

Input channels.........................................8

Cold-junction sensor

Sensor type ......................................Thermistor

Accuracy1 ........................................±0.5 °C from 15 to 35 °C 
±0.9 °C from 0 to 15 °C 
and 35 to 55 °C

Repeatability....................................±0.2 °C from 15 to 35 °C

1   The temperature sensor accuracy includes tolerances in all component values, effects caused by temperature and loading, and 
self-heating. Errors caused by temperature gradients between terminals and the sensor are not included in this specification.
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2.5 V

LM 4040
2.5 V
0.1%

–t 

o 10 µF
16 V
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Output ............................................. 1.91 to 0.65 V 
from 0 to 50 °C

Maximum temperature gradient
between sensor and any terminal .... ±0.4 °C (non-isothermal)

High-voltage divider
Accuracy ................................................ ±0.06% (for 100:1 setting)

Drift................................................. 15 ppm/°C

Resistance ....................................... 1 MΩ
Attenuation ratio ............................. 100:1 or 1:1

on programmatic basis

Common-mode isolation

Channel to channel.......................... 150 Vrms or ±150 VDC

Channel to ground........................... 150 Vrms or ±150 VDC

Coupling.......................................... DC only

Field-wiring connectors

Screw terminals

Signal terminals ....................... 16 (8 pairs)

Functional ground terminals .... 2

Maximum wire gauge .............. 16 AWG

Terminal spacing ..................... 0.5 cm (0.2 in.) center-to-center

Dimensions of front entrance.......... 1.2 × 7.3 cm 
(0.47 × 2.87 in.)

Solder pads for
additional components .................... None

Safety earth-ground lugs ................. 1

Strain relief ..................................... Strain-relief bar at 
terminal-block entrance

Maximum working voltage.................... 150 V
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Physical

Figure 4.  SCXI-1313A DImensions

Weight ....................................................408 g (14.4 oz)

Environment
Operating temperature ............................0 to 50 °C

Storage temperature ................................–20 to 70 °C

Humidity .................................................10 to 90% RH, noncondensing

Maximum altitude...................................2,000 meters

Pollution Degree (indoor use only) ........2

173.5 mm 
(6.83 in.) 

30.3 mm 
(1.19 in.) 

82.5 mm 
(3.25 in.) 

 NATIONAL  
INSTRUMENTS 
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Safety
This product is designed to meet the requirements of the following 
standards of safety for electrical equipment for measurement, control, 
and laboratory use:

• IEC 61010-1, EN 61010-1

• UL 61010-1, CSA 61010-1

Note For UL and other safety certifications, refer to the product label or visit ni.com/
certification, search by model number or product line, and click the appropriate link 
in the Certification column.

Electromagnetic Compatibility
This product is designed to meet the requirements of the following 
standards of EMC for electrical equipment for measurement, control, 
and laboratory use:

• EN 61326 EMC requirements; Minimum Immunity

• EN 55011 Emissions; Group 1, Class A

• CE, C-Tick, ICES, and FCC Part 15 Emissions; Class A

Note For EMC compliance, operate this device according to product documentation.

CE Compliance
This product meets the essential requirements of applicable European 
Directives, as amended for CE marking, as follows:

• 2006/95/EC; Low-Voltage Directive (safety)

• 2004/108/EC; Electromagnetic Compatibility Directive (EMC)

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 
regulatory compliance information. To obtain the DoC for this product, visit ni.com/
certification, search by model number or product line, and click the appropriate link 
in the Certification column.
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Environmental Management
National Instruments is committed to designing and manufacturing 
products in an environmentally responsible manner. NI recognizes that 
eliminating certain hazardous substances from our products is beneficial 
not only to the environment but also to NI customers.

For additional environmental information, refer to the NI and the 
Environment Web page at ni.com/environment. This page contains the 
environmental regulations and directives with which NI complies, as well 
as any other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)
EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling 
center. For more information about WEEE recycling centers and National Instruments 
WEEE initiatives, visit ni.com/environment/weee.htm.

RoHS
National Instruments  (RoHS)

National Instruments RoHS ni.com/environment/rohs_china
(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. 
Refer to the Terms of Use section on ni.com/legal for more information about National 
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade 
names of their respective companies. For patents covering National Instruments products, refer to the 
appropriate location: Help»Patents in your software, the patents.txt file on your CD, or 
ni.com/patents.

© 2007 National Instruments Corporation. All rights reserved. 374636B-01 Oct07
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